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LHCSA Statistical Report and Registration Forms on UDCS 

Instructions 

 

 

Please see Attachment A at the end of this document – it contains descriptions to all items on the tool bars 

located on the top of the Report Manager worksheets. 

 

General Information: 

• Enter information in the blank white fields.  All other fields (pink, lavender, and brown) are read-only 

fields. 

• Some fields are required.  If they are left blank, you will not be able to submit the report 

• Some fields require a Yes or No answer.  You must double click on the blank field and choose Yes or 

No from the box.   

 

 

The Control Data Form 

 

The Control Data Form is part of the Report Manager Software, and collects information about your 

organization that not only identifies you but enables the submission and certification of your report as well as 

the successful transfer of your data to a data repository.   

 

 

When you open the report, you will receive a pop up box that requests that you fill in the Control Data Form.  

You must fill in the Control Data Form prior to submitting the report. 
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The configuration information section will be filled in for you.  You only need to fill in the Contact Person 

and Address sections. 
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Form LSR1 – Agency Form 

 

Form LSR1 - Agency Form collects agency location, contact information and other information.  

 

 
 

 

Agency and Contact Information Section 

All fields in this section, except for NPI number, are required fields.  You will not be able to submit the 

statistical report if this information is not filled in. 

 

 

Additional Information FIs for CDPAP Sections 

The fields in this section require yes or no responses.  You must double click on the blank space and the box 

with the choices will appear. 
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Important Note for ALP LHCSAs - If your LHCSA answers “Yes” to the question “Does this Agency 

EXCLUSIVELY serve patients in an Assisted Living Program?” you are only required to submit: 

• Form LSR1 – Agency Information Form 

• Form LSR2 – Patient Form – the first three questions only  

• Form LSR7 – County Form – Unduplicated Patient Count question only (amount reported on LSR7 

must match the amount on LSR2) 

• Forms LSR9WFA, LSR9WFB, LSR9WFC – Workforce forms A, B, and C 

• Form LSR10 - LHCSA Registration Form.   

You are also required to submit the 2017 ALP LHCSA Statistical Report on the HERDS application of the 

Health Commerce System. 

 

Please note that if your agency is a LHCSA that serves ALP residents and also serves patients in the 

community, select no, and complete and submit all forms of this survey.  Additionally, you must complete and 

submit the 2017 ALP LHCSA Statistical Report on the HERDS application of the Health Commerce System. 
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Form LSR2 – Patient Form 

 

Form LSR2 - Patient Form collects patient demographic information, including discharges and referrals.  

 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
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Patients Section 

Enter information for Patient Census (required).  Enter the patient census as of December 31 of the report 

year (12/31/2017).  Patient Census means the actual number of individual patients receiving services on 

12/31/17. 

 

Next, enter the total number of cases in the Total Cases field (required). A case is an episode of care with a 

start date (admission) and an end date (discharge).  Multiple types of service may be provided during an 

episode of care.  For an episode of care to count as a case for this report the admission date must be in this 

reporting year or prior year(s), and the discharge date must be in this reporting year or the patient must still be 

receiving services at the end of the reporting year.  A patient who has been seen only to be assessed for 

personal care services should not be counted as a case and these visits should not be reported.   

 

A patient sometimes represents more than one case.  However, DO NOT count a patient as a new case if any 

of the following conditions apply: 

• The patient’s age category was changed during the report year 

• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 

• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 

 

Enter the Unduplicated Patient Count in the next field (required).  This is the total number of discrete 

individual patients that your agency has served in the year, regardless of the number of admissions and 

discharges that patient may have had.   A patient is only counted once regardless of the number of cases they 

represent. 

 

To recap, if a patient is receiving care on 12/31/2017 they will be included in the patient census count. If they 

had two admissions during the year, they will count as two cases but as only one unduplicated patient.  

 

Validation Edit - The unduplicated patient count entered on LSR2 must match the total of the unduplicated 

patients reported on forms LSR7 – Services by County Form.  This total is displayed in the first section of 

LSR2 – Patient Form. 

 

Length of Stay Section 

Length of Stay (LOS) information is entered in the next section. LOS is calculated for each episode of care or 

case. Length of stay should be calculated from the date the patient was initially admitted for an episode of 

care, regardless of the year of admission, to the date they were discharged.  For example, if a patient was 

admitted on 12/30/2016 and discharged on 1/10/17 her LOS is 12 days.  Count the 2 days in 2016 and the 10 

days in 2017 to arrive at a 12 day LOS.  Patients that were discharged to a hospital or RHCF and readmitted to 

the agency within 30 days with the same illness or diagnosis should NOT be counted in the length of stay 

section. 

 

Referrals and Discharges Section 

The next section collects patient referral and discharge information. In the “Referred From” column enter the 

number of cases served by your agency that have been referred from each of the designated sources regardless 

of their start of service date. This means that if you are serving a case in 2017 that was referred to your agency 

in 2016, that case should be counted.  Patients that were discharged to a hospital or RHCF and readmitted to 

the agency within 30 days with the same illness or diagnosis should not be counted in the discharge section. 
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In the “Discharged To” column enter the number of cases discharged during the reporting year to specific 

destinations.  

 

Validation Edit - The total number of discharges calculated from the LOS entries must match the total 

number of discharges calculated from the “Discharged To” destination section. 
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Form LSR3 and LSR4 – Revenue Form 

 

Form LSR3 and LSR4 – Revenue Form has two sections (formerly two forms that have been combined onto 

one report worksheet on UDCS): 

 

LSR3 – Contract Revenue Form collects information about revenue received from contracts with other 

agencies to perform services for their patients, or provide equipment to their patients. 

LSR4 – Direct Revenue Form collects data on revenue from services provided to patients directly served by 

your agency (i.e. services are not provided on behalf of another agency).  Direct services may include private 

pay, commercial insurance, and worker’s compensation cases. 
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Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

 

Please note that data on Nursing Services is collected as visits, instead of hours.  If your agency records 

Nursing Services in hours, please count 2.5 hours as 1 visit. 

 

Contracted Services Section 

Begin by answering the Perform Services Question - If your agency DID NOT perform services for, or 

provide equipment to, the patients of other agencies under contract during the report year, answer the first 

question “no” and move down to the Direct Services section of the form.  You may leave the columns blank 

and do not need to enter 0s in these columns.   

 

If your agency DID perform services for or provide equipment to the patients of other agencies under 

contract, enter “yes” for the first question. Enter the number of contract hours and revenue by the type of 

service if you have contracted with another agency, usually a CHHA or an MLTC plan, to provide service on 

their behalf.   

 

Direct Services Section 

Enter the number of hours and revenue by the type of service.   

If your agency did not provide any services directly to any patients, leave the columns blank (you do not have 

to enter 0s). 

 

For both the Contracted Services and the Direct Services - the Gross Revenue is the total revenue received 

for the services or equipment provided before any deductions or allowances. 
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LSR5 – Cost Form 

 

LSR5 – Cost Form - collects data on costs for providing services to patients.  Costs are divided into direct 

and indirect costs.  

 

Direct costs are costs that are clearly associated with the provision of home care patient services. Examples of 

direct costs are staff wages, transportation costs, consumable supplies such as gloves and masks, and the cost 

of providing in-service training to aides.  
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Indirect costs are fringe benefits and payroll taxes as well as costs for activities and materials that are used by 

the entire agency.  

 

The indirect costs are broken out by fringe benefits and other indirect costs, such as administrative and 

general costs, capital and related costs, and other operating costs. 

• Administrative and General costs are expenses for activities and materials that are used to administer 

your business. Examples are rent, utilities, and office supplies. 

• Capital and Related costs are onetime costs for construction, major repairs to real estate owned by the 

agency, etc. 

 

 

 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 
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LSR6 – Staff and Wages Form 

 

LSR6 – Staff and Wages Form - collects information by staff type for full time and hourly staff at two 

different dates during the reporting year and the total number of W2s issued, hours worked, wages, and fringe 

benefits.   

 

 
 

 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Enter the number of full-time and hourly staff at your agency on April 1 and October 1. The current definition 

of a full-time staff is someone who works an average of 30 or more hours a week and 130 hours or more per 

month.   

 

Enter the number of W2s issued, total hours worked, total wages paid, and total fringe benefits paid for each 

staff type.  The amount of wages plus fringe benefits will be calculated in the first lavender column.  The 

second lavender column will divide the total wages and fringe benefits by the total number of hours to 

calculate an average hourly wage.  In the next two columns, enter the lowest hourly rate paid and the highest 

hourly rate paid for each staff type. 
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LSR7– Services by County Form 

 

LSR7 – Services by County Form - collects data on services provided by county.  There is a sheet for each 

county in New York State, in alphabetic order.  The LSR7 worksheets were put at the end of the list of 

worksheets on the left hand side of the screen. 

 

 

 
 

Some of the totals on this form are automatically calculated – they are the lavender fields. 

 

Enter the total number of unduplicated patients, and the number of new admissions during the report year for 

each county that your agency provides services.      

 

An unduplicated patient is an individual who has received at least one episode of care and may have 

received more than one.  Regardless of the number of episodes in the reporting year, the individual is only 

counted once.   

 

New admissions are patients that have been admitted to the agency during the reporting year.  Patients that 

were admitted at a previous time during the report year (or in prior years) and discharged and were admitted 

again during the report year should count as a new admission at the time of admission, with the following 

exceptions: 

DO NOT count a patient as a new admission if any of the following conditions apply: 

• The patient’s age category was changed during the report year 

• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 

• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 

 

Nursing services captures data about nursing services provided to patients in the selected county. The data is 

then broken out by cases and visits, age, and gender (for ages 64+).  If your agency records Nursing Services 

in hours, please count 2.5 hours as 1 visit.  In addition, if your agency is part of the Nurse Family Partnership 

– the number of nursing service cases and visits should be recorded in the selected county.  The Nurse 
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Family Partnership is a program in which nurse home visitors work with low-income young women who are 

pregnant with their first child, helping these vulnerable young clients achieve healthier pregnancies and births, 

stronger child development, and a path toward economic self-sufficiency. 

 

All other services provided to patients in the selected county must be recorded below the Nursing Services 

row. The data is then broken out by cases and hours, age, and gender (for ages 64+).   

 

A case is an episode of service with a start date (admission) and an end date (discharge).  Multiple services 

may be provided during an episode of service.  For an episode of service to count as a case for this report the 

admission date must be in this reporting year or prior year(s), and the discharge date must be in this reporting 

year or the patient must still be receiving services at the end of the reporting year.  A patient who has been 

seen only to be assessed for personal care services should not be counted as a case and these visits should not 

be reported.   

 

A patient sometimes represents more than one case.  However, DO NOT count a patient as a new case if any 

of the following conditions apply: 

• The patient’s age category was changed during the report year 

• The patient was discharged to a hospital or RHCF and readmitted to the agency within 30 days with 

the same illness or diagnosis.  In this instance the discharge should not be counted. 

• The patient was admitted with an unspecified diagnosis and a definite diagnosis was subsequently 

established. 
 

Validation Edit:   If you enter an amount in the “Cases” column you must enter an amount in the 

corresponding “Hours” column.  Also, if you enter an amount in the “Hours” column, you must enter an 

amount in the corresponding “Cases” column. 
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LSR7A – Wellcare  Form 

 

LSR7A – Wellcare Form - collects data about wellcare services provided to patients. Wellcare services 

include services which have as their primary purpose the prevention of illness and obtaining optimum health 

for their recipients.  Examples of such services are nurses performing lead screening assessments, providing 

maternal and child health education, or following up on communicable diseases.   

 

Only County-Operated LHCSAs that provided wellcare services need to complete this form. 

 

 
Some of the totals on this form are automatically calculated – they are the lavender fields. 
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Nursing services captures data about nursing services provided to patients in the selected county. The data is 

then broken out by cases and visits, and gender.  If your agency records Nursing Services in hours, please 

count 2.5 hours as 1 visit.   

 

Private Duty Nursing Services captures data about nursing services provided to patients in the selected 

county. The data is then broken out by cases and hours, and gender.    
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LSR8 – Contracts  Form 

 

LSR8 – Contracts Form - collects information on your agency’s contracts to provide services on behalf of 

another agency.  

 

 

 
 

 

If your agency did not have any contracts to provide services for another agency, answer No to the first 

question, and you are now finished with this form. 

 

If your agency did have contracts to provide services on behalf of another agency, answer Yes to the first 

question, and enter the information for the contract(s).  

 

If it is available, enter the license number/operating certificate number for the agency with whom you are 

contracting. CHHAs and Hospices will have operating certificate numbers. Other organizations may not have 

an operating certificate number.  Enter N/A if the organization does not have an operating certificate or 

license number. 

 

Operating Certificate numbers can be found in the Home Care section on the Profiles webpage 
https://profiles.health.ny.gov/home_care/index.  Hover the mouse at the Home Care tab and you will see 

several ways to search for an agency.  Once you find the agency you are looking for, click on the overview tab 

and open the administration section.  

 

Enter the number of HHA and PCA hours of service you provided under this contract and the amount your 

agency was paid per hour of service.  

 

If the requested information for a given contract changed during the reporting year, enter it as two or more 

separate contracts. 

 

  

https://profiles.health.ny.gov/home_care/index


Send questions to hcstatrpts@health.ny.gov   pg. 18 
 

LSR9WFA – Workforce Form A 

 

LSR9WFA – Workforce Form A - collects information on admissions and the number of cases by 

authorized hours per week for all services. 

 

 

 
 

An agency is closed to admissions when the agency is not accepting any new patients. 
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LSR9WFB – Workforce Form B 

 

LSR9WFB – Workforce Form B - collects information on number of staff employed and assigned to cases, 

and the number of open positions at two points during the year.  This form also collects the number of staff 

that have been employed by your agency for the full report year and the number of staff that have left your 

agency during the report year. 

 

 
 

The number of staff employed on April 1 and October 1 is totaled (count of full time staff plus count of hourly 

staff) and forwarded from form LSR6 – Staff and Wages Form.   

• Enter the number of staff assigned to cases on April 1 and October 1.   

• Enter the number of Open positions on April 1 and October 1.  A position is considered open when an 

agency has advertised for a position but it is not filled.  This includes both hourly and full time 

positions.   

• Enter the number of staff (full time and hourly) that have remained employed by your agency for the 

full report year or more.    

• Enter the number of staff (full time and hourly) that have left your agency (no longer employed by 

your agency) for any reason during the reporting year.  This is a count of workers who left their 

position for any reason – voluntary or involuntary – excluding promotions.  
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LSR9WFC – Workforce Form C 

 

LSR9WFC – Workforce Form C - collects employee benefit information for four types of employees, and 

non wage supports for all staff. 
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LSR10 – Registration Form  

 

LSR10 – Registration Form - collects an attestation that indicates the LHCSA is currently operational and 

serving patients.  If the LHCSA has opened in the past year, you can report on the form that the LHCSA is not 

yet operational and is currently not seeing patients.    

 

The Administrator or Operator must request that the LHCSA be registered with the Department of Health for 

the upcoming calendar year. 
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Validating the Statistical Report 

 

You may, at any time, Validate the Sheet you are working on, or validate the entire Report.  You must 

validate the report before submitting it. 

 

Go to the top tool bar and click on the drop down box next to the green arrow. 

 

 
 

 
 

 

You can validate a worksheet at any time.  You can also refresh the validation after it’s been done once by 

clicking the refresh circle in the details portion of the report.  Because there are so many worksheets, it may 

be easier to validate each worksheet once you’ve finished it.  The results of the validation are in a table in the 

details section of the worksheet.  The message that says “Rule Passed Validation” is only referring to the cell 

you are on – not the whole worksheet. 
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To see if you have any cells with errors – click on the column header that says error – and the list will sort and 

all of the checked boxes will come to the top of the list.  In the screenshot below for form LSR7, the user 

made entries made in the “Cases” column and no corresponding entry in the “Hours” column .  After clicking 

validate worksheet, and clicking the error column header – the errors show up on the list.  

 

 

 
 

 

 

If you have passed the validation edits you will have no error boxes checked and get a green message that 

says Rule Passed Validation for each cell you choose. 

 

Finalizing the Statistical Report 

 

If you have passed all the validation edits, and you are satisfied with all responses on all forms, click on 

Finalize Report. 

 

 
 

A message will come up asking if you are sure you want to save and finalize.  Click Yes. 

A second message will come up directing you to correct errors (if there are any) or letting you know that the 

report has been finalized. 

 

Select a location to save your Finalized Report. 
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Your report is now ready to be submitted to the Healthcare Financial Data Gateway. 

 

 

Submitting the Finalized LHCSA Statistical Report to the Healthcare Financial Data Gateway 

 

1. Login to the HCS. 

2. Click on Healthcare Financial Data Gateway in My Applications. This will take you to the 

Healthcare Financial Data Gateway main page.  
 

 

 
 

 
3. Click the Submissions tab – the Submissions page will display 
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4. Select LHCSA as the Submission Type and your organization from the Organization list and then 

click the Search button. The Submission page will be expanded. 

 

 
 

 

5.  Click the Browse button to display a dialog box that allows you to locate your finalized LHCSA 

Statistical Report. It will have a .pnp file extension.  

6. Once you have selected the file to submit, click the Submit button. 

7. The Submission History section of the Submission page will be updated to reflect the status of the 

submission. 

8. A confirming email message will be sent to the email address listed in the New Submission section of the 

Submission page. 
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Attachment A – Report Tool Bar items 
 

Worksheets 

Worksheets 

 

The Worksheets are listed in the Worksheet Panel which is located on the left side of the application 

window. Worksheets are listed in alphanumeric order by Worksheet name. Click on a Worksheet to view 

that Worksheet in the Matrix Panel. Click on the small arrow key in the top right of the Worksheet Panel to 

collapse or expand the panel. Use the "Windows" menu item to organize your Worksheets in the Matrix 

Panel. 

Title Bar 

Title Bar 

 

The Title Bar is located at the very top of the window and will display the name, version and software build 

number, followed by the name of the active matrix table if a table is currently open. 
 

Menu Bar 

UDCS Menu bar 

 

The following Help Topics will guide you through the menu bar functionality. 

 

File 

The File Menu. 
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Report Manager: Select Report Manager to return to the Report Manager.  

 

New: This command will start a new Report 

 

Open: This command will enable you to open an existing Report 
 

Save: This will save the Report you are working on. 

 

Save Copy To: The Save Copy window will open and enable you to save a copy of your Report to a location 

that you choose. 

Your working report location will remain in the default location: C:\ProgramData\UDCS\report 

 

Print: Two options will be displayed that will enable you to save your Report as a Microsoft Excel 

document or a PDF document. 

For either option, the Select Worksheets window will open. Check the worksheets you wish to export or 

check Select All to check all of the worksheets. 

You will be prompted to save the export file to a location you choose. You can then open the file from this 

saved location and print. 

 

Close Report: Closes the Report. You will be prompted to save your data first. 

 

Exit Program: Closes the UDCS software and the Report Manager. You will be prompted to save your data 

first. 
 

Edit 

The Edit Menu 
 

Cut, Copy, Paste, Undo 
 

 

These features will enable you to copy data from one part of your report to another, or from Microsoft Excel 

to your Report with some limitations: 

1) You may copy numeric data to numeric or non-numeric type cells. You may not copy non-numeric data to 

numeric type cells. 

 

2) You may not paste data into read only cells such as targets of formulas. 

 

3) You may select a range of cells to copy. However, when you paste the cells, the range size must match. If 

the range size does not match, you will not be allowed to copy the data. 
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For example, if you copy a 5 cell by 5 cell range and try to paste in a 3 cell by 3 cell area, or the area has 

read only cells, you will be alerted to adjust your range. 

 

View 

The View Menu 
 

 
 

Report Type: You can choose to Select All Worksheets to display all of the worksheets in the Report in the 

Worksheet display panel. 

For Reports that have multiple Report Types, you may choose to select only the worksheets from the 

selected Report Type. 

 

Worksheet Panel (Expand-Collapse): Expands or collapses the worksheets panel. It may be convenient to 

collapse the worksheet panel 

when you are working on a large worksheet and could use extra space to see more of the worksheet. 

 

With the worksheets collapsed you may also click on the arrow icon where the worksheets are collapsed to 

expand the worksheets. 

Previous Worksheet and Next Worksheet: Use these commands to navigate through the worksheets. 

 

Detail Pane (Expand-Collapse): Use this command to expand or collapse the Details panel. This works 

similarly to 

expand-collapse worksheets. 

 

The following menu items will each open a window that will enable you to Export the data as a text file. 

Calculations: A window will open that lists all of the mathematical expressions in the Report. 

 

Text Transfers: Lists all of the Text Transfers in the Report. 

Text Transfers consist of a value and a target. Once the value is entered, the target will 

automatically get populated with the same value. 
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Validation Rules:Lists all of the Validation Rules in the Report. 

Validation Rules are conditions that must be met in order for the report to be completed 

satisfactorily. 

 

Submission Output: This is the XML output of the Report. It lists Report configuration information 

as well as class code/line numbers and the values that were entered for them. 

 

Configure 

The Configure Menu 

 
 

Control Data: Contains information that is required in order for the Report to be completed correctly and 

allowed to be submitted. 

All required Control Data fields must be complete. Required fields will have a red exclamation point next to 

them. 

When you open the Report, you will be alerted if the Control Data information is not completely filled out. 

 

Report Settings / Report Types: These menu items are merely instructions to remind you what to do in the 

event that you have created 

your report using the wrong configuration information, such as the wrong Report Type or wrong Region. Click 

on the File menu to 

Start a New Report. Select the correct settings and then transfer your data from the incorrect Report to the 

new Report. 

Action 

The Action Menu 
 

 

Validation Method: Current Worksheet or Entire Report. 

In order to Finalize the Report for Submission you must run it through the validation process. You can 

validate to check only 
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the current Worksheet or you can run Validation for the entire Report. You must Validate the entire Report in 

order to 

pass Validation and have a Finalized Report that is ready to submit. 

 

Start Validating/Stop Validating: Once you have selected to validate the current Worksheet or the entire 

Report you can 

select the Start Validating item. For larger Reports, you may choose to Stop Validating at any time. 

 

Notepad 

The Notepad Menu 

 

This is a scratch pad to keep notes and provide additional information while you complete your report. Click 

the File menu and then Save to save Notes to your Report. 

Use the File and Edit menu as you would a typical text editor. 

Windows 

The Windows Menu 

 

Use the Windows commands to arrange the Worksheets to your satisfaction. 

Select the Worksheets command to see a list of opened Worksheets. You may select an open Worksheet to 

bring it to the front of the Report. 
 

 

Search 

The Search Menu 

 

Enter what you would like to search for in the Search box and click the Search button. 

All results that match your Search criteria will be listed below. You may choose to Search 

the Current Worksheet or All Worksheets by toggling the radio buttons at the bottom of the window. 

Help 

The Help Menu 
 

View Documentation will open the Help File that you are currently reading. 
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Click About to open the following window. This information contains details about the Report you have open 

as well as the versions of the software and files being used. 
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Icon Menu 

 
Icon Menu 
 
 
 
 

        Open the Control Data Form. 
 
 
 
 

         Start a New Report. 
 
 
 

       Open an Existing Report. 
 
 
 
 

        Save the Report. 
 
 
 
 

        Close the Report. 
 
 
 
 

        Validate the Current Worksheet or the Entire Report. 
 
 
 
 

        Stop the Validation process. 
 
 
 
 

        Finalize the Report. 
 
 
 
 

        Open Notepad. 
 
 
 
 

        Open the Previous Worksheet. 
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         Open the Next Worksheet. 
 
 
 
 

         Export the Worksheet as a PDF document. 
 
 
 
 
 

         Export the Worksheet as an Excel file. 
 

          Open the Search Window. 
 

 


